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… Books must follow sciences, and not sciences books… 

 [Francis Bacon, Proposition touching Amendment of Laws] 

 

… Young men are fitter to invent than to judge, fitter for execution than for counsel, 
and fitter for new projects than for settled business… 

[Francis Bacon, Of Youth and Age.] 
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1. Set up drawing in AutoCAD.doc 
Act as you like to draw what you are asked for e.g. print tiffs as large as you can, overlay on 
the original tiffs, draw on a new drawing looking to the tiffs only for measures, etc. [Be 
aware that: the quality assurance checks  will be done according to the precise measures and 
the drawing tolerance is very low] 

 

 

 

§ Open a new CAD session 

§ Draw in model space tiled 

§ Create the new layer/s you are proposed to 

§ Give them the Dutch name according to the Carib Layers  

§ Assign them line-type - colour- thickness   

§ Draw the object you have to, as represented in the scanned file/draw you have 

 

 

A 

A- to make a work 
drawing  

B- To make a 
drawing made by 
X-refs  
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§ Define the draw you made as a block (1.) 

§ Save it as a block (2.) according to the naming conventions as contained in the                               
Naming Conventions.doc.  Composed by X-refs 

 

 

§ Open a new CAD session 

§ Import as X-refs all the elements you need to make a complete drawing  

§ Set up the complete drawing 

§ Save it according to Naming Conventions. Complete drawings 

 

 

 

§ Freeze all the X-refs you don’t need any more 

§ Go to MAKE A BLOCK 

§ Type a BLOCK NAME 

§ Click on SELECT OBJECT and select the drawing you want to become a block 

§ Click on SELECT POINT and choose a point on your drawing that seems easy to you 
to insert your block later; so prefer, as possible, the same point to make all the other block 
you will. 

§ Click OK 

§ The next step is to insert the block you made: 

§ Go to INSERT BLOCK 

§ Click on BLOCK and select the block name you just made, OK 

§ Click OK 

§ Place the block on the screen where you want 

§ Now you can delete the drawing you made first 

C- To make a 
complete drawing 

1. To define a 
block in 
AutoCAD 14 
you have to: 
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§ Go to EXPORT DATA 

§ Type in FILE NAME a name according to the Naming Conventions. Doc 

§ You have to choose BLOCK in SAVE AS TYPE 

§ Click OK 

§ Now you will be asked to type the SELECT OBJECT, so type the BLOCK NAME 
you have given. 

 

 

 

§ Go to INSERT-EXTERNAL REFERENCE 

§ Click on ATTACH and select the file you need 

§ Click OK 

§ You can insert only one X-ref. a time 

 

2. To save the 
block you just 
made in 
AutoCAD 14 
you have to: 

3. To import X-
refs in 
AutoCAD 14 
you have to: 
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2. Task definition 

1. Draw Gridlines 
 

raw gridlines as represented on the given drawings in scale 1:50, by using the 
following conventions: 

 

Naming of files 
For this test we will be using the system L, C, A: where L stands for Location, C for 

Component and A for Assemblage.1 The present task will lead to the production of file/s 
named as follows: 

###N(##)## ## ## ## etc. 

Where ### stands for the scale of the paper drawing: in this case 1:50, so the ### 
will be 050. 

N is one of the letter L, C and A: in this case, the N will be L. 

(##) is a code representing the kind of element according to the Dutch 
standardisation system: in this case it will be 00, being the gridlines the base of every 
drawings. 

## ## ## ## are the element represented in the drawing itself, their numbers are 
progressive, and in this case, being the gridlines the first drawing to be done, and the 
drawing containing just them there will be only a ## being 00. 

The name will then be 050L(00)00.dwg 

                                                                    
1 L= Location, these drawings are normally plans, sections, facades; the L represents the “scene of the action”, the 

stage, the “location” and it is used to orient into the project. 
  C= Component, these drawings are normally complete representations of elements. Their names refer to the 

Dutch standardisation system and point to a specific element/material. They can also be imagined as “abaci” 
of elements in a building object.  

  A= Assemblage, these drawings are details and they normally refer to L and C drawings. 

D 
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Drawing conventions: 
 

For the representation of the Gridlines of these paper drawings use the following 
conventions: 

 

Gridlines Elements Line-type  Colour Line weight Scale Y/N 

Gridlines Dash-dot Green ByBlock Visible Yes 

Dimensions Continuous Red ByBlock “ Yes 

Arrowheads Origin Indicator Yellow ByBlock 175 d.u. Yes 

Extension lines     No 

3,5 Texts Standard Yellow  175 d.u. Yes 

10,0 Texts2 Standard Purple  500 d.u. Yes 

 

The grey-shadowed boxes refer to the main element composing the x-refs. 

Y/N refers to the element being drawn or not. 

 

                                                                    

2 The letters referring to an intersection of gridlines, should be drawn to a distance, centre to centre with the crossing 
point, of 1.000 drawing units. 
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2. Draw concrete elements 
 

raw concrete elements one by one as x-refs, and as represented on the 
given drawings in scale 1:50, by using the following conventions: 

 

Naming of files 
 

For this test we will be using the system L, C, A: where L stands for Location, C for 
Component and A for Assemblage. The present task will lead to the production of file/s 
named as follows: 

###N(##)## ## ## ## etc. 

Where ### stands for the scale of the paper drawing: in this case 1:50, so the ### 
will be 050. 

N is one of the letter L, C and A: in this case, the N will be C. 

(##) is a code representing the kind of element according to the Dutch 
standardisation system: in this case it will be 28, being the number 28 the code for Frame 
(columns, concrete elements, etc.) refer to layer conventions. 

## ## ## ## are the element represented in the drawing itself, their numbers are 
progressive, and in this case, the drawing process should lead to the production of different 
DWG files with only a ## being 01, 02, 03, 04, etc. depending on the number of different 
concrete elements. 

The names will then be 050C(28)01.dwg, 050C(28)02.dwg, 050C(28)03.dwg, 
050C(28)04.dwg, etc. 

 

 

 

D 
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Drawing conventions: 
 

For the representation of the Concrete elements of these paper drawings use the 
following conventions: 

 

Concrete 
lements 

Elements Line-type  Colour Line weight Scale Y/N 

Concrete 
elements 

Continuous Cyan ByBlock Visible Yes 

Hatching Continuous 45º White ByBlock Visible Yes 

Dimensions Continuous Red ByBlock “ Yes 

Arrowheads Origin Indicator Yellow ByBlock 175 d.u. Yes 

Extension lines     No 

3,5 Texts Standard Yellow  175 d.u. Yes 

 

  

The grey-shadowed boxes refer to the main element composing the x-refs. 

Y/N refers to the element being drawn or not. 
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3. Draw concrete elements by floor at height 
±0,00 

ompose plan at level ±0,00 as represented on the given drawings in scale 1:50, by 
using the following conventions and by placing the previously created x-refs at 
their right position in one x-ref.: 
 

Naming of files 
 

For this test we will be using the system L, C, A: where L stands for Location, C for 
Component and A for Assemblage. The present task will lead to the production of file/s 
named as follows: 

###N(##)## 

Where ### stands for the scale of the paper drawing: in this case 1:50, so the ### 
will be 050. 

N is one of the letter L, C and A: in this case, the N will be L. 

 (##) is a code representing the kind of element according to the Dutch 
standardisation system: in this case it will be 28, being the number 28 the code for Frame 
(columns, concrete elements, etc.) refer to layer conventions. 

 ## is the number representing in the drawing itself, the specific floor-plan and it is 
progressive, normally the Dutch architects start considering the Ground Floor as level 
number 1, so in this case, the drawing representing different elements of the same kind at 
Ground floor [Frame (columns, concrete elements, etc.) refer to layer conventions] thus the 
process should lead to the production of a DWG file containing just a ##. 

The name will then be for example 050L(28)01.dwg, 

It can also be represented as an interval: 050L(28)01.dwg 

 

 

 

 

C 
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Drawing conventions: 
 

For the representation of the Concrete elements by floor of these paper drawings 
the conventions previously mentioned for concrete elements apply: 

 

Concrete 
lements 

Elements Line-type  Colour Line weight Scale Y/N 

Concrete 
elements 

Continuous Cyan ByBlock Visible Yes 

Hatching Continuous 45º White ByBlock Visible Yes 

Dimensions Continuous Red ByBlock “ Yes 

Arrowheads Origin Indicator Yellow ByBlock 175 d.u. Yes 

Extension lines     No 

3,5 Texts Standard Yellow  175 d.u. Yes 

 

  

The grey-shadowed boxes refer to the main element composing the x-refs. 

Y/N refers to the element being drawn or not. 
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4. Other procedures to be defined: 

§ Draw external walls by floor at height 
±X,XX 

§ Hatch external walls 

§ Draw internal walls by floor at height ±X,XX 

§ Hatch internal walls 

§ Draw external frames 

§ Draw dimensions 

§ Draw sanitary fittings 

§ Etc. 
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3. Conventions definition
The following conventions have to be defined: 

Folder 1 
FORMATS AND PLYINGS
Font: ISO 5457-1980 

NEN 2302 

 
In this folder will be collected all the 
general rules for the presentation of 
information on architectonic drawings. 
These rules are useful for all the kind of 
architectural drawings an office is 
involved in: projects, landscape 
architecture, construction engineering, 
building technologies, housing and 
interior architecture. All the given 
measures are intended in millimetres, 
except if expressly said the contrary. 
 
 

DRAWING FORMATS 
 

The standard format of drawings will be 
inserted in the standardised A Series. 
Starting from format A0, with a surface 
of 1 square meter and sides in rapport 1: 
square root 2, it is possible to obtain by 
successive bisections the normalised 

formats with the same rapport between 
sides. Let us use formats A0 and A1 at 
least. 

 
A0  841 x 1.189 
A1  594 x    841 

 
 

MARGINS AND PLYING SIMBOLS 
 

The preceding dimensions will be used as 
a margin for the cutting line of plotted 
sheets. The title is located normally in the 
right lower corner of plans (the used 
positions are marked with a T in the 
following Figures). In order to allow the 
reproduction on microfilms it is necessary 
to mark, on the borders, the centring 
references (Figure 1.1). 

PLYING 



 
 
 
 
 
A P P E N D I X E S  -  S T A N D A R D S  
 

C a r i b C A D  C a r i b C A D  --  T U D  P a r t n e r T U D  P a r t n e r   T i t l e :  A P P E N D I X E S  
  R e v i s i o n :  0 6 - 0 1 - 0 0  
R e f e r e n c e :  0 5 - A  D a t e :   0 3 - 0 5 - 9 9  
I s s u e  # :  0 1  V C  P a g e :   1 3  O F  1 5   

Folder 2. 
TITOLS 
Font: ISO 
 
 

DIMENSIONS AND POSITION 
 

A principal space and eventual 
supplementary spaces compose the title 
of a plan. The title can be in one of the 
following dimensions: 
 
Small:  180/60 mm 
Medium:  180/100 mm 
Large:  180/180 mm 
 

The supplementary spaces are 180 mm 
large no matter the height. But it is 
strongly recommended not to exceed 
the total dimensions (included those 
spaces) of 180x285 mm. 
 
Normally speaking, the title is 
located in the right lower corner, 
located 5-mm far from the right and 
lower cutting lines. The 
supplementary spaces must be 
added over the principal one. 
 
 

CONTENT 
 

Principal space: 
The title should almost tell the 
following information on owner, plan 
contents, project author and plan 
identifications: 
 
Owner: - Name 
Content: - Project name 
 - Name of the represented part  

(articulation) 
- Plan title (constructive element, kind of 
work etc.) 

 - Scale 
Author: - Office name 
 - Address 
Identific.: - Number of the plan 
 -  Modifications identification 

- Date 
 

 
 
It is also possible to give information 
about: 
 
Owner: - Address 
Content: - Modifications content 
Author: - Progressive office number 
 - Drawer’s name 
Identific.: - Format 
 

Supplementary spaces: 
Can be useful to indicate location plans, 
north arrows, graphical scales, legends 
or in case of overlaying techniques, for 
naming the single plans and their 
authors. 
 
 

DISPOSITION 
 

It is not supposed to follow any 
particular rule. Practically it has been 
reasonable and rational to use the 
following disposition (drawing). The 
used surface of each one of the four 
groups must be determined case by 
case according to the amount of 
information to be shown.
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Folder 3 
SCALES 
Font: ISO 5455 – 1979 
 
 

THE USED SCALE MUST APPEAR IN 
THE TITLE OF EACH PLAN. 
In the architectonic field, the following 
scales are used: 
 
1: 1 1:10 1:100 1:1000 1:10000 
 - 1:20 1:200 1:2000 - 
1: 5 1:50 1:500 1:5000 - 
 

Due to the normal office practise of 
reducing plans, it is strongly 
recommended to draw on each plan a 
graphical scale, which allows retrieving 
the approximate measures of a reduced 
drawing. Reductions and enlargements 
must be always indicated. 

 
 

Scale Usual Architects’ Application 

1:10000 
1: 5000 
1: 2000 

General Plans 
(e.g. Zones plans) 

1: 1000 
1:   500 

Situation Plans, Cadastral Plans 

1:   200 Situation Plans in Urban Zones 
Contest Projects 
Preliminary Projects 

1:   100 Final Projects 

1:     50 Constructive Plans 

1:     20 
1:     10 
1:       5 
1:       1 

Detailing 

Executive 

Figure 3.1 Usual Architectonic Scales
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Folder 4.Folder 4.  
STANDARDISED TEXTES 
Font: ISO 
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Folder  5.Folder  5.  
LINES 
Font: ISO 128 – 1982 
 NEN 2302 
 
 

LINE THICKNESS 
 
 

It is common practice not to use more 
than three different line thickness in the 
same drawing. It is advised to strongly 
differentiate the line thickness, 
choosing for example a combination 
0,25-0,5-1,0 mm instead of the 0,25-
0,35-0,5 mm combination. Please 
consider the final plan format, the scale 
and the reduction factor for the choice 
of lines. 
 

Usual thickness of Rapido lines: 
0,18 
0,25 
0,35 
0,50 
0,70 
1,00 
1,40 
2,00 
 
 

KIND OF LINES 
 
 

Continue 
Hatched 
Dash-dot 
Dotted 
Free hand 
 
All the other kinds are only used as 
conventional symbols (Sheet 9). 
 
 

APPLICATION 
 
 

The principal application cases are 
indicated in the following table. Use 

 
 
stronger or thinner lines to give 
emphasis to some special elements. A 
fourth kind of line (very thick) can be 
used in showing the sectioned ground. 
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TABLE OF LINES 
Folder  6.Folder  6.  
AXES AND CO-ORDINATES 
Font: ISO 
 
 

AXES 
 
 

The axial network allows an easier way 
of drawing and the analysis of the 
project in sectors of circa the same 
dimensions. The main axes can be 
subdivided into secondary ones. 
 
 

COORDINATES 
 
 

When representing big and large 
situations or plans, it is possible to use 
a local system of co-ordinates for a 
better orientation, in the drawing itself. 
It is good practice to give different 
starting values to the x and y co-
ordinates. 
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Notes about the Quality 
Assurance processes and 
testing 

 

 

 

§ The kind of drawing: details, plans, sections, façades, axonometrics, perspectives, 
and sketches. 

§ The kind of support on which originally it has been represented. 

§ The number and kind of reproduction processes, the final copies are the result of. 

 

 

 

 

§ In Task 1 phase, the very detailed checking of every single element composing a 
drawing with reference to agreed procedure/manual/standards. 

§ In Task 2 phase, a less detailed checking for macroscopic mistakes. 

§ In Task 3 phase, a relationship of mutual understanding and co-operation, should 
already be the background in which the entire process takes place, thus not 
needing very detailed QA. 

 

Chapter 

B 
1. Precision of paper based drawings 
depends on: 

2. CaribCAD meaning for Quality-
Assurance, it is: 
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§ It is clear that it is not possible to expect any more quality than the one 
represented on the original drawings. 

§ Still, it is possible to expect as in the normal practice that some limited and 
reasonable approximations will be done with respect to some very standardised 
elements. 

§ It was proposed that a tolerance could be accepted, but as everyone involved in 
building processes/field can easily understand, a copy of a drawing is precise or 
not, and the cases in which a copy being not precise can be tolerated are really not 
worth to talk about. 

§ The proposed way is to draw just the elements for which a precise measure is 
given or those that can be easily calculated out of measured ones. 

 

 

3. Accepted quality with respect to the 
starting media's precision: 
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Seven Keys to Creating 
a Professional Manual 
Like the Chapter Title Style above, and the Chapter Subtitle 
you’re reading, Word’s pre-set Styles are just a few clicks away. 

o save time in the future, print a copy of this document. Choose Print from 
the File menu, and press Enter to receive all 8 pages of examples and 
instructions. With the printed document in hand, position yourself in Normal 
View to see the Style names next to each paragraph. Scroll through the 

document and write the Style names next to the paragraphs (press Ctrl-Home to 
reposition yourself at the beginning of the document). 

To create a drop cap for the lead paragraph, like the example above, select and 
highlight the letter T, and type a new letter. 

How to Customise This Manual 
The “icon key” at left was produced using the Heading 8 Style for the words “icon 
key,” and the List Bullet 5 Style for the text below which uses a Wingdings symbol 
for the bullet character. To change the bullet symbol, choose Bullets and Numbering 
from the Format menu. Click modify, and click the Bullet button. Choose a new 
symbol, and click OK twice to exit. 

About the “Picture” Icons 
The “picture” icons are Wingdings typeface symbols formatted in white with a shaded 
background. To insert a new symbol, highlight the character and choose Symbol from 
the Insert menu—select a new symbol, choose Insert, and Close. To create new 
“icons,” format a one-character paragraph as the Icon 1 Style. 

To change the shading of the Icon 1 Style, choose Borders and Shading from the 
Format menu. Select a new shade or colour, and choose OK to accept your choice. 

Section Breaks are Key 

Chapter 

C1 

T 
I C O N  K E Y  

1 Valuable information

! Test your knowledge 

: Keyboard exercise 

& Workbook review 

11
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In this manual, section breaks are the secret to success. Double-click the section break 
above to activate the Page Set-up menu. Choose the Margins tab. As you can see, this 
section (page) has margins of 3.17 centimetres top and bottom, 5.5 left, and 2 right—
with headers and footers of 1.69 centimetres. Special section margins make it possible 
for this manual to use framed Styles—such as the Icon 1 Style—which will move 
with the text. 

• Breaks in a Word document appear as “labelled,” dotted double-lines. 

• To insert a section break, choose Break from the Insert menu. Select 
one option, and click OK to accept your choice. 

About Pictures and Captions 
Assuming you see your paragraph marks, you’ll notice a paragraph mark attached to 
the bottom right corner of the picture. Click on the picture, and notice too, the name 
of the Style—not surprisingly, the Picture Style. Pictures “attached” to paragraph 
Styles make it possible for pictures to “act” like paragraphs. 

 

FIGURE 21.1 uses this caption text. In Word, the Caption Style can be automatically numbered and labelled. Choose Caption 
from the Insert menu to access and control the caption settings. For more information, press the F1 key to search for additional 
information and help on captions. 

To change the picture, first click on it to select it. Then, point to Picture on the 
Insert menu and choose From File. Uncheck the Float over Text checkbox. Select a 
new picture, and click Insert. To change the colour of the picture, double-click on the 
graphic to activate the drawing layer—where you can group or ungroup picture 
objects, and re-colour or delete objects. Click on an object, and choose Drawing 
Object from the Format menu. Choose a new shade, and choose Close. To delete an 
object, select it, and press Delete. Click the Close Picture button to exit. 

To crop the picture, click on the picture. Hold the Shift key down and re-size the 
picture by moving the picture “handles” with your mouse. 

Try this: click your cursor in the framed text at left, and choose Body Text from the 
Style drop-down list at the top left of your screen. Assuming you did, the headline 
should now appear as the paragraph below this paragraph. To change the paragraph 
back to Heading 5, click the Undo button, or choose Heading 5 from the Style list. 

Using the Breaks 
command, you can insert a 
page, column, or section 
break. 

This is Heading 5. 
Like all Styles in 
this margin, it can 
flow with the text. 
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To cut and paste framed text, click on the bounding border of the frame to reveal the 
frame handles. Press Ctrl-X to cut the frame from the page. Click your cursor before 
the first letter of the paragraph that you would like the frame to appear next to. Press 
Ctrl-V to paste the frame next to the paragraph. 

How to Generate a Table of Contents 
To create a Table of Contents, position your cursor before the word, “introduction.” 
Holding the Shift key down, drag and select both columns of text up to and including 
the paragraph mark attached to the “Index” entry (last line, second column). From 
the Insert menu, choose Index and Tables. Click on the Table of Contents tab. Select 
the Custom format, and click OK. The Table of Contents will be automatically 
updated with words contained in Headings 1-3. 

Note 

The sample TOC text uses the Section Heading Style to create chapter 
headings. However, the headings must be manually typed and formatted 
with the Section Heading Style. (“Note” text uses the Block Quotation 
First Style for the heading, and the Block Quotation Style for the text.) 

How to Create an Index 
To create index entries for Word’s automatic indexing feature, select the text to be 
indexed, and choose Index and Tables from the Insert menu. Click the Index tab to 
receive the Index dialog box with options. (For more information, select Microsoft 
Word Help from the Help menu, type “index” into the question space, and click the 
search button. Finally, select the “Create an Index” help topic.) 

How to Change the Headers and Footers 
In Page Layout view, double-click on the header or footer to activate it, or choose 
Header and Footer from the View menu. Once activated, you can change or delete 
the text just like regular text.  

1. To create a numbered paragraph like this, choose the List Number 
Style. If you choose to format more than one paragraph, Word will 
automatically number the paragraphs. 

How To Save Time in the Future 
When you re-save the manual template with your changes, the creation of future 
documents becomes easier. To customise this manual, select File New to re-open this 
template as a document. 

Framed text, like 
this heading, can 
be cut, copied and 
pasted like regular 
paragraph text. 

ÊÊ
ÊÊWritten exercise 
pages 121 - 123 in your 
workbook. 
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1. Insert your company information in place of the sample text on the cover 
page, as well as the inside-cover page. If you plan to use Styles such as the 
“Icon Key” or Icon 1 Style, set them now (see instructions, page 1). 

2. Choose File Save As. In the menu, choose Document Template in the 
Save File as Type: box. (The filename extension should change from .doc 
to .dot.) Save the file under a new name to protect the original version, or 
use the same template name to replace the existing version. 

How to Create a Document 
To create a manual from your newly saved template, select File New to re-open your 
template as a document. Assuming you followed the steps above, your company 
information should appear in place. Now, simply type your manual. 

More Template Tips 
There are three ways to view the various Style names of the template sample text: 

1. In Normal view, choose Tools Options. Click the View tab. In the Style 
Area Width box, dial up a number and click OK; or 

2. In Page Layout view, click on any paragraph and view the style name on 
the Formatting toolbar; or 

3. From the Format menu, choose Style Gallery. In the Preview section, 
click on Style Samples. 

 

To link a picture to 
your template, link the 
picture when you insert it by 
clicking on the Link to File 
box. 

77



A P P E N D I X E S  –  P R O P O S E D  T O O L S  
 

  C a r i b C A D  C a r i b C A D  --  T U D  P a r t n e r T U D  P a r t n e r  T i t l e :  A P P E N D I X E S  
 R e v i s i o n :     0 6 - 0 1 - 0 0  
 R e f e r e n c e :  0 5 - A  D a t e :   0 3 - 0 5 - 9 9  
 I s s u e  # :  0 1  V C  P A G E :   5  O F  2 7   

Proposed tools 
This document defines the base line I.T. implementation 
driven by the requirement analysis from the pilot project 1 
and 2 and by testing different I.T. and CAD issues.  An 
analysis is given of  the basic features that need to be 
supported together with a description of  the WFM software 
components that can support these features3. 

uring CaribCAD 's life, it emerged in many different 
occasions and with different implications, the urging 
necessity to relate all of the different aspects as a 
unique balanced combination of Technical basis, 

Human capacities, and Protocols. It can be foreseen this to result in positive 
outcomes in Outsourcing of Computer Aided Design/Drafting (CAD) 
workloads from engineering companies in Europe (EU) to specialised 
companies in Developing Countries (DC). 
 
As expressed in the final documents provided by the Newcastle's team, the 
objectives of CaribCAD were never "to develop advanced computing solutions 
to concurrent engineering in construction". Still, the entire testing performed in 
many different occasions by different and various CaribCAD partners proved in 
an unmistakable and evident way that failures, lacks or missing decisions on 
Technical basis, Human capacities, and Protocols results in more or less severe 
failures in an Outsourcing results. 
 
The following documents must be put in relation with the document contained 
in 04 Outsourcing Manual.doc defined as GroupWare Practical. The following 
discussion of tool issues by University of Newcastle and Funredes, as annotated 
in blue by TUD lets the reader having hopefully a clear image of the situation, of 
the enormous potentialities as well as the problems to be defined and solved. 

                                                                    

3 The present document apart from being the exposition of what has been researched by TUD, it is a 
modified, commented version of: 

- "Feasibility Study and Baseline Implementation Definition" by S.R.Lockley 
- FUNREDES Comments on "Feasibility Study and Baseline…" by CD-DP (FUNREDES) 
- A reaction to Funredes' comments by S.R. Lockley 
- Further documents, discussions 
 

Chapter 

D 

Foreword: D 
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The final conclusions are meant to be a sort of reference for future outsourcers 
on which tool issues to define previously to start outsourcing. 
 
Again and for the moment the advice, then, is to require, previously to any kind 
of Outsourcing, a neutral advice on the state of the art in Information 
Technology, specific advice for the particular situation. Finally but not less 
important extensive instruction on the proper use of the adopted tools, as is the 
case of CAD programs. 
 

he analysis of the pilot projects has been carried out by:  
 
 
 

• Reviewing the current and desired I.T. environments in the CAD bureaux; 
• Analysing the informal models produced in tasks 3.1and 3.2; 
• Considering the state-of-the-art in CAD and WFM in their respective 

industries. 
 

 
The analysis is presented by topic, 
 

• Communication 
• CAD file / Document Management 
• Collaboration and Work Flow 

Communication 
Building upon the experiences of the project communication to date and the 
guidelines for project communication it is clear that in order to make e-mail- 
based communication effective the following actions are required 

• Each person must have their own e-mail address  
• E-mail should be delivered to the person’s desktop; they should not 
be required to look for it.  
• Email communications need to be archived where they can be 
easily reviewed and retrieved.  
• Email targeting is very important. i.e. General list broadcast with 
each person looking to see what is relevant to them is not desirable, 
mails should be sent to those who need to read and act upon them only 
• Email formatting / templates are needed to structure information 
content. 
 

"Each person must have their own e-mail address" 
 

Pilot Projects Analysis T 
I C O N  K E Y  

* Communication 

' CAD file / Document 

Management 

E Collaboration and 

Work Flow 

* 
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Within the scope of general project communication this has been an issue that 
has been addressed. All those who are part of the project management should 
now have their own Internet email address, i.e. every staff member within the 
individual companies has their own email account with an Independent Service 
Provider (ISP). However, within the remit of the Pilot Projects where we wish to 
widen the number of people who are communicating between the organisations, 
there are possible problems with this approach. The problems are 

1. Staff Training, how Internet literate do we expect these staff to be?  
2. Access, at present most of the CAD partners have to go to a machine 

that has the modem connected in order to use their mail account  
3. Cost, ISP's sometimes charge more for more accounts  
4. Security, there is an implicit fear of letting all staff have general access to 

the internet  
5. Control over staff usage of email, fear of time wasting.  
6. Maintenance/ Movement of staff, as staff come and go email accounts 

have to be administered and monitored 
There are solutions available to overcome some of these problems. 
 
While these texts were meant to define CaribCAD scopes and necessities, they 
can also be used together with the comments resulting from the actual 
application of those ideas, to set up new Outsourcing projects. Moreover it is 
strongly advised not to limit the field of intervention to e-mails, a media that 
already at present is rather obsolete compared to different most advanced media 
that are available all over the Net. 
 

1. For small companies (1-4 internet users), then the modem and dial up 
connection is probably a simple and suitable solution and the problems 
above can be controlled by good discipline and training. 

2. For medium to large companies (5 internet user plus) a common 
solution is for the company to register a domain name for their business 
and then to allocate their own email addresses within that domain. E.g. 
EGM's may register "@EGM.NL" as their domain and no matter what 
name precedes this their ISP will forward mail to EGM's server. It is the 
responsibility of EGM at their server to look at the name preceding the 
domain and forward it to an internal recipient. This is a very useful 
mechanism and ideal for medium to large companies who can invest in 
setting-up and maintaining the infrastructure. It gives them control over 
the security issues and allows them to monitor and act on time wasting 
and provides prompts to the recipients that mail has arrived. Actually 
this solution seems more and more suitable for small companies and not 
only for big companies seen the wide diffusion of the Internet, the 
reductions in costs and the necessity, even for small companies to have 
an internal network / connection that allows the employees to 
exchange/share data, programs, etc. with their colleagues,. 
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Either of the above two solutions may work the second is a more extensible 
solution, however, both effect and impact upon the normal business 
arrangements of the companies. …Omissis…4 

3. A third and more viable approach is to move the setting up of mail 
accounts from the wider Internet domain and the CAD bureaux to WP2 
and in effect to create a CaribCAD Intranet within the Internet. This 
would entail WP2 hosting the mailboxes for each of the Piloteers. In this 
way we keep a clear distinction between CaribCAD Pilot work and 
general business e-mail. 

This is just the perfect solution, allowing more freedom to both small and big 
companies and providing a trustworthy system, seen the legal implications of the 
Internet contracting. It can provide a solution for mail services as well as 
Internet specialistic communities and services, shared programs, tools, hard disk 
space, etc. 
 
"E-mail should be delivered to the persons desktop, they should not be required to look for it." 
 
This is really an issue of discipline/training versus management. In an ideal 
world, all employees would be self-motivated, proactive individuals who would 
be disciplined enough to check their mail every hour and respond. In reality we 
know this is not the case and we have observed that pressures of time and work 
greatly effect peoples motivation and discipline. There are technical solutions as 
outlined above but this should be discussed. A possible solution is to appoint an 
information gatekeeper on each site who receives notification of all messages 
sent to staff at that site. Their role is not to understand or read the mail merely 
to bring it to the attention of the recipient (who would then go and retrieve their 
mail). This gatekeeper could be a secretarial position. NB it is not suggested that 
this person print out the mails and takes them to the recipient, this would 
undermine the CaribCAD objective. 
 
"Email communications need to be archived where they can be easily reviewed and retrieved." 
 
This is an issue of robustness (if a mail is lost or accidentally deleted it can be 
quickly and easily retrieved) and commercial confidence (the CAD file was sent 
on the 23/5/98). …Omissis…5 
 

                                                                    

4 Comments specific for CaribCAD: It was considered that this was not desirable in CaribCAD. Setting up 
either of these environments has a price for each of the CAD bureaux, which could delay progress on the 
real issues in hand. We already have some experience of this with the problems that partners have had 
setting up their mail environment. 

5 Comments specific for CaribCAD: The initial proposal was to create an archive within the CaribCAD 
Intranet for each pilot, and to use custom email templates, through which the sender could choose to 
archive the mail or not. Certain tasks would have special templates where archiving would be mandatory or 
not. E.G the form for submitting a CAD file to the document repository will automatically notify the 
archive of the action. 
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"Email targeting and Email formatting / templates are needed to structure information 
content." 
 
Email targeting is very important. I.e. General list broadcast with each person 
looking to see what is relevant to them is not desirable; mails should be sent to 
those who need to read and act upon them only.  
There are several ways in which email targeting can be made more effective 

1. Wrap the sending and subject details up in predefined forms so that 
there is controlled consistency and meaning in the mails  

2. Set up mailing lists of roles rather than people, where a role maps to one 
or more people. E.g. if you want the scanning department to rescan a 
drawing, you don't send a mail to the person who did the last one but to 
the group "scanning department". This then allows the businesses to 
provide responses in a flexible and well-covered manner. They do not 
have to worry if "scanner person A" is on holiday that week.  

3. Using routing with exception handling to automatically deal with non-
response, e.g. if you send a mail that requires a reply, if the reply is not 
received within say, 24 hours then the supervisor of the department is 
notified. 

 
All the tests held by CaribCAD proved that not just one, but a well-assorted 
mixture of the three above mentioned systems is the best solution, thus solving 
almost all of the different problems with the methodology ad hoc. 
 

CAD file / Document Management  
…Omissis…6 Actually the esteem done for CaribCAD was quite correct except 
that Pilot 1 was not more aligned with Document Imaging than Management 
where documents are exchanged between the two organisations, in fact all 
failures were due to lack of proper management. In a few occasions, the 
documents were more than expected, and without an organising system, it 
would have been a problem to browse into them, the advice is not 
underestimate the problem, and foresee since the beginning a flexible and 
adaptable system. For the rest, content search and indexing and searching 
support will be necessary in case of multiple Outsourcing. What is required 
though is 

                                                                    
6 Comments specific for CaribCAD: The two pilots had different document management requirements. At 
first glance Pilot 1 was more aligned with Document Imaging than Management where documents were 
exchanged between the two organisations. However, these systems give high levels of support to document 
retrieval and searching, it was unlikely that within any typical pilot project there would have been so many 
documents that finding the right one could be a problem. There was no need to search the content of the 
CAD file for specific words. Therefore we did not need the index and searching support that is a feature of 
most document management systems. The traditional drawing list approach should have been adequate. In 
addition the sophisticated features such as "reverse delta change management" did not appear to be 
necessary. 

''
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• A project centric document archive held on a server outside both 
organisations; 

• A shadow of this archive held in each organisation containing working 
versions rather than committed versions; 

• The facility to add (upload) a document (CAD file or any document) to 
the server archiving and to attach meta-information to that document; 

• The facility to get a document and for all parties to know the document 
is in use; 

• The facility to request an action on a document and to know when that 
action has begun and is complete; 

• The facility to quickly preview documents over the WEB and print them 
before retrieving them; [actually this is just necessary if the client wants 
his own clients to access the projects under construction / development 
remotely, otherwise, the CAD tools themselves already provides enough 
easiness of files handling. And moreover are the only ways to perform 
effective quality checks]. 

• The ability to review versions and changes/differences visually; [actually 
this is only possible for macroscopic changes, for small modifications of 
the CAD drawing, an automated routine/program could be the only 
possibility]. 

• Permissions control on who can read, write, create, delete documents in 
the server archive; [this is a very important issue, especially for legal 
implications]. 

• Automate the distribution of documents for approval and comment;  
• The facility to maintain relationships between a CAD file and other 

externally referenced CAD files; [this is also a key point, due to the 
procedure based on the Depot and the X-ref. System] 

“A project centric document archive held on a server outside bot  
“A shadow of this archive held in each organisation containing working versions rather than 

 
“The facility to add (upload) a document (CAD file or any document) to the server archiving 
and to attach meta-information to that document” 
“The facility to get a document and for all parties to know the document is in use” 

7  
                                                                    

7 Comments specific for CaribCAD: The pilots needed a relatively simple document archive where a file 
and its versions could be stored in a simple hierarchical framework. This file needed to be supported by a 
set of meta-data giving it meaning to the user prior to it being opened. There was only one added 
complication in pilot 2 where there was a necessity to support CAD documents that were made up from 
(or reference) other documents, this would have to be coded by WP2. [Actually also pilot 1 had the 
necessity to support CAD documents that were made up from (or reference) other documents]. Simple 
“check-in/out” mechanisms were needed with permissions control. It was unlikely that we would need any 
kind of "reverse delta" or other version storage mechanisms. This had the advantage of reducing disk space 
requirements and allowing the differences in versions to be viewed. Commercial applications that do this 
are available but we could easily work around this by investing in a bit of extra disk space and using a 
simple and inexpensive CAD differencing software tool. [Practically the problems were solved by naming 
the files according to the sequential order they were produced, but resulted in human mistakes, where the 
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To summarise we can support the document management needs [of the pilots] 
by using the basic GroupWare facilities and excepting that we may not be 
making efficient use of inexpensive disk space.  
"The facility to request an action on a document and to know when that action has begun and 
is complete." 
Several tools that support this have been reviewed they include: 

• Project  
• Team Leader  
• Team Manager 
• Action Workflow 

They all have a similar underlying approach in that they build upon the basic 
Internet mail item. A typical approach is to model an action or task as collection 
of mail items that have been extended by adding extra "user" fields e.g. Start 
date, End date, Percentage Complete, Requested By. They then present these 
groups of items as a single action with a history of changes.  
A downside to all of these tools is that carry the overhead of being designed for 
different purposes than those required by CaribCAD. For example Project 
manages the amount of time and resource used in tasks, we did not need this, as 
it was internal to the organisations. Again it was likely that for CaribCAD we 
could avoid the use of these tools and customise a basic GroupWare items such 
as a mail or a task to meet our needs.[actually what happened was that without 
those tools it was very difficult to manage files, tasks, and people]. 
"The facility to quickly preview documents over the WEB and print them before retrieving 
them" 
"The ability to review versions and changes/differences visually" 
Four tools have been identified as main candidates that can preview CAD files. 
The tools are 

• Intravision  
• AutoView Manager  
• Dr DWG  
• Myriad 
• Autodesk VoloView 

These tools provide similar facilities, these are 
• CAD File viewing for a wide range of types  
• Redlining/Mark-up or annotation  
• Printing/Plotting 

Intravision has more sophisticated rendering facilities and better support for 3D 
and STEP but these were not facilities we needed in the Pilots [at present]. 
Myriad has limited capabilities in its freeware version. …Omissis… 
Dr DWG is the most useful candidate, in that it can operate as a web browser 
plug in and read DWG and DXF files. It has a very useful server component 
that will support sharing of redlining and comments through the GroupWare 
                                                                                                                                                                               
care by the performer was not enough. Luckily the problem was circumscribed to a few files, thus easily 
corrigible]. 
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interface as well as help with the viewing of drawings on the server. It met all 
CaribCAD needs apart from the function to show differences in CAD drawings. 
[At this very moment, VoloView is the best package by meeting all CaribCAD 
needs included the function to show differences in CAD drawings. Unknown 
are its capabilities as a server component].  The best package for this is 
AutoView Manager. However, this does not support the viewing of WEB CAD 
file formats. These file formats are designed to reduce the size of the drawing so 
that they can be viewed over the WEB very quickly. They typically reduce the 
file size to 20% of the original therefore making transmission five times faster. 
There are two key-WEB specific formats for CAD,  

• Standard Vector Format (SVF)  
• Drawing Web Format (DWF) 

Essentially both of them convert a CAD drawing into a vector only 
representation and strip out all the other information content. The result is a 
smaller file, which can be download and viewed quickly by a WEB browser with 
the relevant plug-in, but cannot be edited in anyway. [At this moment, this is a 
very important point, and gives by itself reasons enough for not using those 
formats for exchanging CAD files, but just for very limited visual purposes. 
Every Building practice needs to be able to work on the CAD files, not just see 
them]. 
SVF, is a vector graphics format, which supports hyperlinks and layer 
information. SoftSource and NCSA to provide a useful 2-D vector format for 
use on the World Wide Web jointly developed it. The files can contain other 
data which isn't necessarily picked up by a viewer so extra information can be 
embedded in the file, this information is not used for display. 
DWF is a highly compressed 2D-vector electronic plots graphics file. It 
represents a drawing, but does not contain the actual data behind the geometry. 
The DWG file format retains all the information-rich data components, such as 
arcs, vectors, splines, and annotations, as well as extended entity data. 
Given the functionality of the CAD tools available at present there are two 
possible technical solutions to this aspect 

1. Use Auto Manager viewing tool to view the files when they are on the 
local machine and see differences between them but use a separate 
browser "plug-in" (WHIP or other) to view the files on the server in a 
WEB format.  

2. Use a DR DWG plug-in to view the files both on the local machine and 
on the server but do not use a WEB format, and forego at this moment 
the ability to review differences. 

The proposal was to use the second alternative and in the initial stages of the 
project accept the slower download speeds and lack of difference checking and 
see how much of a problem this was. The reasons for this were 

1. It reduces the number of file conversions, all files are stored in a single 
format on the server (we did not have the full CAD file and a WEB 
format version, only the CAD file), there is less chance of error  

2. It is only necessary to buy one software set of licenses  
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3. Dr DWG supports all version of AutoCAD DWG and DXF files (inc. 
14)  

4. Although the ability to see CAD file differences is lost, a lot of 
integration with the server side is gained. This would allow us to reliable 
exchange comments and redlines on CAD files, which appeared more 
important than viewing differences at present. [Practically it was just the 
opposite, and it was necessary to open files one by one and check them 
in detail; the use of x-refs. solved the problem]. 

5. If we will need to see differences we can purchase AutoManager at a 
later date.  

6. There was already a beta version of Dr DWG, which could read WEB 
file formats if we needed them to make the transfer speed acceptable. 

General Document Viewing and annotating is slightly different, there is a range 
of WEB based document viewers and editors, perhaps the most common are 
the Adobe Acrobat editor/viewer and the Microsoft Word editor/editor. The 
decision was really on the cost of the editor; if a CAD office has Adobe 
Publisher they will not wish to switch to WORD and vice versa. It was proposed 
that both viewers should be supported by all offices with the choice of editor 
left to the individual. 
"Permissions control on who can read, write, create, delete documents in the server archive" 
This is a basic facility supported by virtually all GroupWare environments. 
"Automate the distribution of documents for approval and comment." 
Surprisingly, this facility is not generally available in the mainstream GroupWare 
tools. It is normally referred to as routing and it is partially supported in the 
office type applications, for example a word processing document can be routed 
through a sequence of recipients for comment. But these are not very robust 
mechanisms and there is poor control over what happens when an error occurs 
or a recipient doesn't respond. …Omissis…8 
"The facility to maintain relationships between a CAD file and other externally referenced 
CAD files" 
Both Pilot 1 and 2 needed to use the fairly standard CAD facility to make 
references between one CAD file and other. For example, if a hospital layout 
has 100 standard hospital bed arrangements to be drawn on each floor, the CAD 
technician will simply insert a reference a single drawing of a standard bed 
arrangement. Rather than draw the same thing 100 times or insert 100 copies of 
the same drawing that would make the file very large. These are normally 
referred to as external reference libraries. Every CAD file can reference many 
other CAD files. The problem for CaribCAD was that when a file was 
transferred to the CAD bureau for editing it was necessary to also ensure that all 
the latest version of those files it references were also transferred. This is a 
facility that should be provided by the document management software but 

                                                                    
8 Comments specific for CaribCAD: It might be that this was out of scope for the first (baseline) pass 
implementation of the pilots. We have examined some beta version of routing tools and found them to 
perform acceptably, they were scheduled to be released as final versions this year [last year], if they do so we 
can easily extend WP2 support in this area if it is necessary. [Actually it was and is necessary but has not 
been completely or reliably implemented]. 
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normally only exists in high-end expensive packages. Investigations to date led 
us to believe that WP2 could deliver this mechanism. This is a very important 
aspect of the situation, being the procedure proposed by TUD based almost 
completely on x-refs. 

Collaboration and Workflow 
"Workflow Management by definition is the proactive computer system that manages the flow 
of work among participants according to defined procedures consisting of a number of tasks. It 
co-ordinates users and systems, participants, together with the appropriate data resource, which 
maybe directly accessible by the system or off line to achieve defined objectives by set deadlines. 
The co-ordination involves passing tasks from participant to participant in correct sequence, 
ensuring that all fulfil their required contributions taking default actions when necessary" 
(Hale&Lavery, 1991). 
Workflow management (WFM) is not a new discipline and over the last twenty 
or more years there has been available a wide range of WFM software and 
methodologies. However, these have mostly been highly specialised or 
proprietary systems. With the advent and establishment of sophisticated group-
ware environments WFM has become more mainstream and aligned with these 
commercial software tools. At first this took the form of extensions to existing 
group-ware tools such as Lotus Notes, then over time these extensions became 
an integral part of the group-ware tools. In essence WFM and Group-ware are 
merging into one solution and it is difficult to draw clear boundaries between 
the two. As well as technology standardisation there are also moves towards 
theoretical standardisation through such groups as the WFM coalition. 
The WFM Coalition produced a general model of the main components of a 
work flow environment, the components and relationships between them. 
(Figure 1) 
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Figure 1 WorkFlow Components and Interfaces 
This is a good basic model to describe the CaribCAD workflow components, it 
is useful to outline the relationships between the tools we used in CaribCAD 
and the interfaces described here. 
 

Workflow Enactment Service: 
at the core are the Workflow engine, enactment service and interfaces. This was 
in essence the group-ware tool in CaribCAD, possible solutions are Sun/Solaris, 
Lotus Domino, Microsoft Exchange and Novell Inc.'s GroupWise. 
 
The Process Definition tools are the tools that we currently used to develop our 
models of the Pilot projects. These ranges from informal modelling tools such 
as flow charts, through more formal diagramming techniques such as the WEB 
based view [of Pilot 1 and 2] to formal models created with a WFM tool such as 
the Action Workflow process builder. 

 
Figure 2 the Different Workflow Enactment Services - Example provided 
by Microsoft and about one of their servers. 
These are the mail reader tools such as Eudora, Exchange, Outlook, Pegasus, 
WEB browsers as well as more sophisticated tools that handle calendars/diaries, 
tasks, CAD file viewing, PDF file viewing. They run on the local machine in our 
offices rather than on the external servers [such as that at Funredes]. 
 

Interface 1:Interface 1: 

Interface 2:Interface 2:  
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For CaribCAD examples of these were the CAD applications, AutoCAD, Arkey, 
Microstation etc. as well as document editing tools such as Word or Excel. They 
are third party applications for specialised tasks. A simple interface to these may 
be "execute the program and open this document", a more complex interface 
may be a task that happens in background such as "convert this file from DWG 
to DXF" 
 
This is communication between two or more enactment services, for example 
the server in CAD bureau 1 may need to synchronise the data it contains with 
that in CAD bureau 2 or request an action from a user in that office. It was 
unlikely that we would need this level of complexity in CaribCAD. [Actually it 
was required in many cases and will be necessary in real Outsourcing]. 
 
Essentially this involves administering and monitoring activity in the enactment 
engine, typical examples are adding new users, responding to non-delivery of 
mails. The only real issue for CaribCAD was how we distribute administrative 
tasks, for example, who was responsible for adding new users, the CAD bureaux 
or was it a centralised WP2 activity. It was proposed that in the early stages we 
would adopt the latter approach. In many cases this was too restrictive and it 
was asked to have more flexibility/freedom, or the alternative was to have a sort 
of “slave” in Newcastle to implement all the requests. A real system should be 
completely flexible and divided in different groups, each responsible for its 
components, but with some administrator roles. 
It can be seen from this brief overview that certain de-facto choices had already 
been made: the browsers, the mail clients, and the CAD packages. After the 
completion of CaribCAD those choices can be evaluated and judged: the 
conclusion is that in many cases they were adequate to simple testing and to the 
contingent reality, but incapable to foresee the future or normal problems 
caused by a real practice. For a real outsourcing, very deep requirement analysis 
must be done and it is also necessary to exceed to some extents the prudential 
estimations. There remained the following decisions to be made 

• The Enactment Service  
• The Process Definition Tool 

Based on trials and paper reviews of the main candidates for these two areas the 
recommendation to WP2 was that Collaborative Data Objects with Microsoft 
Exchange Server would be used as the Enactment Service and Action Workflow 
Manager used as the Process definition tool. These reasons for this choice are 
discussed further. 
 

Enactment Service 
There are three main contenders in the commercial GroupWare area, Lotus 
Development Corp.'s Domino, Microsoft Corp.'s Exchange and Novell Inc.'s 
GroupWise [lately also Sun Solaris joined the group with full rights] 

Interface 3:Interface 3:  

Interface 4:Interface 4: 

Interface 5:Interface 5: 
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The following is a summary of reviews carried out on the products. 
All three systems support the common Internet protocols, such as POP (Post 
Office Protocol) 3 HTTP SMTP, and IMAP (Internet Messaging Access 
Protocol). 
Domino the server-component of Lotus Notes is the most customisable of the 
GroupWare packages and supports the most varied number of hardware 
platforms. 
Microsoft Exchange has not been very configurable until the 5.5 release, which 
contains server-based scripting that, integrates well with Microsoft's Windows 
NT and its Internet Information Server. 
GroupWise messaging system is the least extendable although they pioneered a 
number of developments in the messaging category these have now been 
adopted by Exchange and Domino. For example, GroupWise allows items to be 
converted into different message types, such as changing an E-mail note into an 
appointment or a task. 
The need to configure and "tweak" to meet CaribCAD requirements means that 
the choice of server component is between Domino and Microsoft Exchange. 
Exchange is proposed because 

1. The WEB server integration is very powerful allowing us to access all 
GroupWare facilities through a WEB interface. Removing the need for 
any specialist client software tools at interface 2.  

2. The customisation of items through the Collaborative Data Objects 
Interface provides a very extensible system [that would allow WP2 to 
quickly and easily create Internet objects for highly specialised tasks e.g. 
Project Objects, Drawing Objects, Scanned Objects. Note that it was 
also a necessity of WP1, although not fully understood].  

3. The single client interface provided by Exchange is easy to understand 
and install, whereas the Domino client interface, in contrast, uses a 
variety of subprograms for mail, scheduling and database access, making 
things more confusing for end users and administrators alike. We found 
this interface very difficult to understand. 

An advantage and disadvantage of Exchange is its close relationships with 
Windows NT, on the one hand this makes aspects such as security and 
administration very simple but on the other it reduces portability to other 
environments such as UNIX. 
 

Process Engineering Component 
A key factor in choosing a modelling tool for this component is the underlying 
representation the model tool assumes. A wide range of WFM modelling tools 
were considered but preference was given to those tools, which incorporated the 
work of the WFM coalition. 
A key issue in identifying the correct tool is the nature of the business process 
being modelled. At first glance Pilot 2 had more advanced collaboration 
requirements than Pilot 1, but it was apparent that this simplistic view turned 
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out incorrect as a better understanding of both pilots was achieved. Pilot 1 
essentially was a repetition of a fairly consistent set of operations with the need 
to resolve specific problems as they arise, it followed closely an Input / Output 
(IPO) model of workflow. Whereas Pilot 2 was focused entirely on problem 
definition and resolution, requiring a high degree of collaboration and 
negotiation between the two organisations. This was more in line with recent 
WFM developments sometimes referred to as the Language Action Approach 
(LA). 
The IPO models the problem as a series of tasks or activities with a set of 
inputs, a process that modifies the inputs and a set of resulting outputs. In the 
Pilot 1 model the inputs and outputs were documents of one form or another. 
For problems of a mechanistic nature this is a valid approach. 
However, if the problem is people centred and the focus is on the interaction 
and conversations between those people then the IPO model may not be 
appropriate. And that was effectively the case of Pilot 1 turned out to be 
different from what expected. The LA approach models the problem as a series 
of tasks that are moved by conversation through four distinct phases,  

1. Preparation, resulting in an offer or request to do work,  
2. Negotiation, resulting in agreement to do the work,  
3. Performance, resulting in execution of the work and  
4. Acceptance, resulting in an assessment of the satisfactory completion of 

the task. 
Throughout these four phases each task has a customer, who wants the job 
done, a performer, who will do the job and onlookers who are monitoring 
progress. 
It was clear from the review of the pilots that both would benefit from this 
approach. To produce a model that can be executed by the enactment service it 
is essential to know, who will request a task to be performed, who is expected to 
execute it and where it should go next. Therefore we had to deal with this in our 
models; the Action Workflow tool can model these facets and check the 
consistency of the result. 
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Baseline Implementation 
Based on the analysis described earlier a two-part implementation strategy was 
proposed 
 
 

• Definition of the Data and Process Models [for the core pilot 
environment].  

• Identification and configuration of software tools. 

Definition of the Data and Process Models 
Both pilots had the need to handle and exchange CAD drawings. Since the Delft 
workshop it had become clear that scanned drawings might not need any special 
consideration. 
Figure 3 illustrates the top-level view of the data model proposed to support the 
CAD drawings needs of the Pilots. The words in circles are objects the lines 
between the circles relationships between those objects and the letters "1" and 
"M" the cardinality of those relationships (1 or Many). 

  
Figure 3 Data Model Overview 
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This is only the top-level view of the key CaribCAD data components and their 
relationships. In addition we needed to consider the attributes of these objects 
and the relationship to Internet Items or objects. 
We have adopted the Collaborative Data Objects (CDO) Model for Internet 
Items; the following shows the relationship between these and the CaribCAD 
objects. 

 
Figure 4 Relationship to Collaborative Data Objects 
The arrow terminated line indicates inheritance or "Special Kind of". All the 
CDO items have the facility to support programmatically added fields of a wide 
range of types. These will be used to add attribute data, such as "Drawing Title", 
"Scan Resolution" etc. 
The following was the first attempt to determine the attributes/fields that will 
need to be added to each object over and above those that were inherited from 
the CDO layer. Where the "Folder." Or "Message." notation is used it indicates 
that an inherited CDO attribute is employed. 
 
Name [Folder Name] 
 
Name [Folder Name] 
 
Created [Date] 
Reference Number [String] 

Title [Message Subject] 
Public Release Version [String] 
Latest Revision [Number] 
Scale [String] 
CAD File Type [String] 
Comments [Message Subject] 

 
Description [Message Body] 
Number [Number] 

Created Date [Date] 
 
Planned Start [Date] 
Actual Start [Date] 

Planned End [Date] 
Actual End [Date] 
Completion Status [Enumeration] 

Project 

Drawing Type 

Drawing 

Revision 

Task 
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Percentage Complete [Number] 
Assigned To [String] 
Assigned By [String] 

 
Inserted By [String]  
Inserted On [Date] 
 
This was only a brief overview more detailed work was needed in this definition. 

Process Models 
Based on the two informal Pilot models a general CAD transaction process 
model was proposed. The lifecycle of a CAD file had been mapped throughout 
its usage within the project and the processes that surround this had been 
abstracted into five models, they are 

1 Create Drawing/Document 
2 Edit Drawing/Document 
3 Review Drawing/Document 
4 Issue Drawing/Document 
5 Plot Drawing/Document 

Informal models were then made for each of these areas. They are 
 
 
 
 

a. Specify Project  
b. Identify Drawing/Document Type  
c. Identify Reference Drawings/Documents  
d. Prepare Drawing/Document Meta Data  
e. Nominate Editors  
f. Nominate Readers  
g. Nominate Reviewers  
h. Nominate Owner  
i. Invoke the create operation (NB no CAD file or document file exists)  
j. Receive confirmation of creation. 
h. Notify owner of its existence. 

 
 
 
 

a. Define the editing work to be executed  
b. Identify and locate the relevant drawing/document  
c. Allocate work and agree/negotiate time-scale  
d. Accept/Understand work to be done  
e. Check out the Drawing/Document  
f. Raise queries about work to be done as they occur  

Reference 

1 Create Drawing/Document 

2 Edit Drawing/Document 
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g. Monitor progress/status of editing operation  
h. Notify that editing is complete  
i. Review editing work, comment redline etc. (Invoke "Review 

Drawing/Document" session)  
j. Approve drawing/document  
k. Issue Drawing (Invoke Issue CAD file model) 

 
 
 
 

a. Receive instruction drawing is ready for review  
b. Obtain project and drawing requirements (what is needed, brief etc.)  
c. Redline and comment on drawing (This and the next three are not 

necessarily sequential)  
d. Raise queries with Editors  
e. Issue drawing (make it public) or  
f. Invoke a new "Edit Drawing" session 

 
 
 
 

a. Identify recipient  
b. Prepare transmittal advice  
c. Transmit package to public area  
d. Notify recipients of its availability  
e. Recipients acknowledge receipt  
f. Recipients invoke "Review Drawing/Document" session  
g. If review requires changes sender invokes another "Edit 

Drawing/Document" session  
h. If recipient approves drawing the "Issue for Construction" 

It should be noted that these were general process models for Pilot 1 and Pilot 
2, they needed to be extended to meet the specific needs of the formal models 
currently under development. Here are a few examples of how these fit into 
Pilot 1 model, 

Item 1.1 Prepare Initial Instruction Document 
Item 1.2 Comment on Instruction Document 
Item 1.3 Revise Instruction Document 

Have counterparts of  
"Create Document", "Edit Document", "Review Document", "Issue 
Document" 
In the more CAD specific areas,  

Item 3.3.1 Draw elements until correct and 
Item 3.3.1 Check Correctness 

Have a direct counterpart as they decompose into a "Create Drawing" followed 
by a series of "Edit Drawing" operations followed by a "Review Drawing" and 
finally an "Issue Drawing" 

3) Review Drawing/Document 

4) Issue CAD Drawing/Document 
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The difference between the WP2 model and the Pilot models was that the WP2 
model had no specific project application and needed to be configured for a 
specific project related set of actions. The precise level of project configuration 
that should have been done by WP2 needed to be determined. Examples of 
areas where agreement needed to be attained between whether it was better for 
WP2 to configure the environment or the CAD bureaux were 

• The identity and configuration of the project team  
• The exact structure and content of the project information stores  
• Automated or manual routing of tasks between members 

Identification and configuration of software tools 
It was proposed to have the minimum number of 
applications in the CAD offices, where possible all 
work would be done through a WEB browser with 
the minimum dependency on plug-ins and Java 

applets. Where possible basic HTML and scripting languages would be 
employed with the maximum use of software execution on a server.  
Two main browsers would be supported Netscape Navigator 3 (or later) and 
Microsoft Internet Explorer 3 (or later). No extra efforts were made to support 
others. 
Attempts would be made to support Macintosh as well as PC's [but if these 
efforts become detrimental to the outcome of the project then Macintosh 
support will be withdrawn] There should be no cost implication to partners in 
this area. 

The key exception to these objectives was in the area 
of CAD and document viewing tools. It was 
proposed to use DR DWG as a browser plug-in to 
view CAD files at the local machine and over the 
network. This came as two software components,  

1. A Java based browser extension to view DWF files (Beta no current 
charge) 

2. A browser plug-in that allows AutoCAD 11,12,13 and14 DXF and 
DWG to be viewed and printed, $40-50 per license. An evaluation of 
this can be obtained from 
http://www.drdwg.com/netview.htm 

Client Tools (In the CAD offices) 

Client CAD Viewing Tools (In the 
CAD offices) 
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The CAD editing tools currently in use in the 
bureaux were to be accepted. …Omissis…9 
…Omissis…10  
For viewing documents (PDF, WORD etc.) it was 
proposed to install WORD 97 viewer and ADOBE 

Acrobat viewer on all machines, these are freeware. Word 97 can be obtained in 
16 or 32 bit versions from http://eu.microsoft.com/word/internet/viewer 
ADOBE Acrobat viewer can be obtained from 
http://www.adobe.com/prodindex/acrobat/readstep.html. 

It was proposed to build the CaribCAD data store 
and messaging facilities on top of Microsoft 
Exchange Server 5.5 using Collaborative Data 
Objects and Active Server Pages. The cost of this 

would have been around $2000 for up to 25 CaribCAD users. We were looking 
at reducing this through per client licensing. In addition we would need the 
server component of Dr DWG for managing and sharing redlining facilities, this 
is in the region of a few hundred dollars and would allow users to exchange 
comments on CAD work to be done via the server. 
…Omissis… 
 

Note 

The sample TOC text uses the Section Heading Style to create chapter 
headings. However, the headings must be manually typed and 
formatted with the Section Heading Style. (“Note” text uses the Block 
Quotation First Style for the heading, and the Block Quotation Style 
for the text.) 

 

FUNREDES Comments on "Feasibility Study and 
Baseline…” 
 

                                                                    

9 Comments specific for CaribCAD: A conversion tool would be produced by WP2 that transforms 
AutoCAD DWG files into validated DXF files ready for submission to the server. This would be delivered 
in two phases, the first phase version would convert the file and check it is graphically valid, the second 
phase version would check that only CaribCAD valid graphical entities are being exchanged. It was not 
done and moreover it was decided to use DWG files, being the standard de-facto in CAD formats. 

10 Comments specific for CaribCAD: Annotating and redlining of CAD drawings would be provided by the Dr DWG 
tool and corresponding server based component that would integrate and manage comments for the drawing team. This 
is described in the following server section. 

Client CAD Editing Tools (In the CAD 
offices) 

Server Environment 
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The above mentioned document presents an articulated and coherent approach 
for the solution of communication and information requirements within the pilot 
projects 1 and 2 of the CaribCAD project.  
 

Funredes would have felt more comfortable with an 
approach where the requirements would have been 
explicitly identified, presented, analysed, debated and 
published. The part of the requirements, which are 

exclusive characteristics of remote CAD collaborative activities, should have 
deserved deeper analysis to drive, from the requirements, the corresponding 
solutions. This would have allowed drawing more precise frontiers with generic 
solutions from the areas of GroupWare, workflow management or EDI. In the 
absence of precise description of the requirements, the risk is taken to offer too 
broad solutions and to come to a "belief" oriented position rather than problem 
oriented.  
Two different approaches are contending: "Internet rooted" vs. "business as 
usual "  
Our activity on Internet based collaborative environment, applied to the specifics of 
CAD, is getting to the dilemma proper of the state of the art of the Internet. 
Two contending visions of the whole Internet are currently prevailing. It is 
difficult to take a neutral position without a clear and thorough knowledge and 
analysis of the C&I requirements drawn by remote CAD collaborative activities. 
And a precise identification of the subset of the requirements which are 
dedicated or specific to CAD (as compare to other activities performed in a 
remote collaborative environment). Rather than arguing again in favour of one 
of the approaches, we prefer to take some distance.  
We offer then a synthetic and schematic comparison of the two prevailing 
approaches, of the philosophy and believe which sustain them and on the 
concrete solutions they propose. The presence of these contending approaches 
was not typical of our project environment. A similar situation can be recognised 
in many areas, with more or less paroxysm, comparing with what has happened 
currently in the CaribCAD project.  
 

This approach, which is reflected in the "Funredes 
Position Paper", considers that the Internet goes far 
beyond the fact of using C&I tools, and represents a 
new paradigm in the working environment. The 

vision could be considered as a natural extension of the young history of the 
Internet where some collective values have emerged, which can be characterised 
by the following terms: bottom-up, self-reinforced regulation, netiquette, 
proactivity (or “push”11), etc.  
                                                                    

11 Push vs. Pull approach: in the traditional Internet environment, the user goes to the information by a 
decided move, the "interactivity" is the buzzword. In the "pull" approach the information reaches directly 
the user without explicit request providing situation similar to "broadcast" media, although with the added-
value of the personalisation of the broadcast selection. 

The requirements are not exposed as such 

The "Internet rooted" approach 
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The approach will focus Internet training (cultures and methods more than tool) 
and methodology as the appropriate resources to build a working environment. 
The tool aspect is not ignored, but it is focused in a generic manner (learn how 
to use an e-mail agent rather than such software). Two main rationales support 
that position:  

• A "pragmatic" one, which takes into account the tremendous 
development of new software, the personal preferences and the 
variations in infrastructure. What is taught today may become obsolete 
faster if the learner is tight to a specific software environment.  

• A "philosophical" one, which pretends to develop the capacity to deal 
with a variety of situation in a fast evolving environment, thus 
empowering the users rather than making them prisoners of a particular 
software.  

Incidentally, this vision does not recognise the dominance of any specific 
platform, hardware or software, and pays intense attention to the compatibility 
issues. This is clear and interesting, but probably not really focused on the issues 
that CaribCAD has researched. Training can go on, and the tests had 
demonstrated it, indefinitely, without producing valuable result except 
frustrations. A generic training, moreover is not practicable, as Funredes well 
points out the environment is fast evolving and subject to tremendous 
development. As it is always the case, the best way to self-instruct on I.T. 
matters is to use and peruse all the available tools, rather than studying, being 
trained, and abstracting from the battlefield. 
 

For the contender of this approach, the Internet is, 
above all, another set of Communication and 
Information tools which must be integrated to the 
current platforms and working environments. These 

"plug and play" tools must be adapted to the working environment and not the 
other way around. The so-called "Internet culture" is considered as a 
reminiscence of the origin of the technology which has now to disappear (or at 
least to shadow) while "business as usual" takes over. The approach often 
proposes Microsoft environment and software as appropriate resources to build 
a working environment. For this point it is necessary to read the further reply by 
S.R.Lockley. 
 

In spite of the existence of a number of "pull" 
proposals, there is no evidence yet within the 
Internet world that the second approach is taking 
over the first one. It is common to see businesses, 

which are using the Internet, rooted approach to develop and this is probably 
the case of the most successful ones within the Internet at the moment12. 
Although the future will probably show the coexistence of a plurality of 
                                                                    

12 Two representative examples are amazon.com and geocities.com. 

The “Business as usual” approach 

A middle term? 
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approaches and the emergence of more balanced visions, the opposition 
between the two approaches is today very important and have to be 
acknowledged in the Internet environment as well as in the CaribCAD project.  
This is another interesting point, although a little bit dated. It is for all the 
nineties that the researches in IT were directed to integrate and make coexisting 
different approaches and platforms. The client, if not provided by the market, 
searches the more balanced vision, and if it is true that software houses are not 
always looking for integration but opposition, it is also true that this is firmly but 
inexorably changing in the last years. 
 

This very schematic framework being set-up, one 
should go to pragmatics and decision within the 
CaribCAD project. The hazard had played an 
interesting challenge to the CaribCAD project 

putting together in the same project groups that are very "extremes" in each of 
the two approaches.  
Funredes has worked and is still working in appropriate methodologies for group 
environment within the scope of "Internet rooted" approach. (The partners who aim at 
getting more in details the gist of our approach may want to read the annex: we 
document there the broad directions in which we investigate in other projects 
and environments).  
The Newcastle University Architecture Department appears to be a heavy user 
of Microsoft products and strong believer of the "business as usual" approach. 
This brought an interesting dilemma to the project. Insofar, as it seemed quite 
difficult, if not totally impossible, to define a middle term position, it seemed 
equally complicated to ask any of the "extremist" parties to adopt the vision that 
is opposite to his own. Probably this is just an aspect of the entire situation, the 
other aspect is that the Internet world is so rapidly changing that extremism’s are 
day by day less and less perceivable thus making it completely absurd an idealist 
thus, per se extremist, concept about Internet, Netiquette, and Virtual 
Communities. 
 

One way to overcome the dilemma was clearly and 
definitively split the responsibilities of C&I between 
the project and the pilots. In the previous situation, 
the boundary of C&I responsibilities within the 

project, as far as Pilots were concerned, has never been clearly stated and many 
honest attempts of the parties, with good and sound intentions to clear the point 
had failed. In the recommended new situation, Funredes retired any proactive 
responsibilities concerning the pilots C&I and only reacted, on request, for consulting 
on his field of competence (or commenting reports when they are provided). 
Consulting could be correctly performed providing the requests were exposed 
with a clear separation of the requirements from the solutions. Consulting 
obviously could not include training proprietary packages (this must be included 
in the cost of providing such packages, being the package free of charge or not) 

The CaribCAD dilemma 

Pragmatics 
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but certainly could include the verification of the application of such or such 
functionality of the commercial packages.  
For instance, if we were asked about the convenience of using OutlookTM13 "in a 
web environment" vs. "in a PC environment", we would answer that our 
recommendation is strongly and definitively for the PC environment. 
Messaging in a web environment, unless the companies dispose of leased lines, is 
a cumbersome and low productivity activity. In a dial-up environment, reading 
and writing mails should not be done online. Furthermore, in a web based 
messaging interface, the writing of e-mails could take as much as 5 times longer 
than in an off-line PC environment. These inconveniences may not appear 
during benchmarks where only few mails are exchanged but definitively are 
killers in a real life professional environment. Those are all good points that 
highlight the main problem being the necessity to define case by case the needs 
of every firms willing to outsource or convert to C.&I. Moreover it points out 
that to be successful in the IT re-conversion or uses two are the possibilities: 
always having the latest technology with very high economical costs and due to 
the local situations not always feasible, or deciding for the right cocktail of tools, 
procedures and pieces of hardware suitable for a specific situation and try to 
keep it up-to-dated as much as possible. Situations different from these 
inevitably bring to failures or reduced competitiveness. 
 

…Omissis… 
Our belief is that both approaches could provide a 
workable result but that the "Internet rooted" would 
present a higher productivity and flexibility and a 

much more open platform. On the other hand, the second approach may lead to 
a more "easy to start" environment but will probably be constrained by 
proprietary packages and deeply dependent on these packages.  
…Omissis… 
 

Although two opposite positions were supported 
within the CaribCAD team, we are convinced that a 
“modus-vivendi” could be found for the remaining 
of the project life based on the split of C&I 

responsibilities as mentioned. 
However, we do perceive two remaining unsolved issues and offer them to the 
group reflections:  

1. Can we move along this applied research without a clear separation from 
requirements to solutions? 

No, a requirement is very important and should be previous to any kind of 
research, development, and solution. 

2. The "business as usual" approach need to build a software environment. 
Can the group proceed in this building without respecting, until the 

                                                                    

13 Trademark of Microsoft. 

Perspectives 

Remaining issues 
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software environment is operational, the rules of the current state of the 
art of the Internet14. 

This is not completely clear, but if respecting the rules of the current state of the 
art of the Internet means staying blocked to some tenths of years ago, not 
progressing, paralysis etc. the reply is definitely yes. If the idea is that out of past 
and present experiences a better software environment can result, again the reply 
invites to see the present further developments that differ from the past of IT 
light years. For sure the basic concepts are still the same, basic methods as well, 
but connections, portability, potentialities, procedures, have been improved in 
an unforeseeable way. 

A reaction to Funredes's comments 
The Funredes comments raise an issue which needs to be addressed, that is, are 
there two approaches to the technical solutions of WP2, the "Internet Rooted 
Approach" and the "Business as usually approach"? 
Firstly, UNINEW do not consider that these two approaches are mutually 
exclusive. Business is in a transition from paper based working through digital 
media to distributed (Internet) working. In making this transition it always has to 
maintain its revenue stream and train staff to employ new methods of working 
and technologies. The need for training and the introduction of new working 
practice are indivisible. Therefore it is not a tenable argument to make an 
either… or situation. We believe that the baseline implementation definition 
recognises this problem very clearly and is a solely Internet rooted solution to a 
business problem. We justify this as follows 

1. At the core of our proposal are the standard Internet Mail and the WEB 
browser technologies. We have gone to great lengths to ensure that 
where possible the "user" is only dealing with standard Internet rooted 
technologies and methodologies. It can be seen that we have purposely 
not proposed using software tools that would lead users to become 
"prisoners of a particular software".  

2. Although we use sophisticated proprietary software tools on the server, 
all interfaces between the clients and the server are using agreed internet 
technologies (HTTP, POP3, SMTP etc)  

                                                                    

14 The first sending of the commented document in the CaribCAD listserv rather than putting it directly on 
the FTP server was a good example of the problem. By doing so Steve was coherent with the approach he 
is proposing. However, the length of the file made it rejected by the listserv program, which has been built 
in conformity with the rules the Internet community has stated and which say that there is a limit of the 
size of the file which could be sent via a listserv. Note that this limit is not bound to technical problems, 
but to netiquette, for it is not appropriated to receive large files without request. That may take too much 
time at an inadequate moment, and among 20 or 30 people they reach, there will be some that are less 
interested than others. Please also note that the same problem occurs with HTML in listservs: it is very nice 
to exchange messages with special fonts, sizes, colours, in a software environment that display their nice 
features, but listservs do not accept this type of encoding. In spite of various warnings by FUNREDES, 
the sending of such messages is becoming the standard de facto in CaribCAD, a situation which is a burden 
for everyone, and which should definitely not have happened. 
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Secondly, if UNINEW were consulted by the EU we would advise that 
Communication and Information tools should be integrated to the current 
platforms and working environments, but that this does not mean that these 
platforms and working environments will not change with time or even during 
introduction. The remit of this project is essentially to develop new working 
practices; UNINEW supports evolution rather than revolution. In fact with 
reference to the comment on Microsoft, they are successful precisely because of 
this approach not just their software engineering skills. 
Thirdly, UNINEW do not perceive the Internet as a culture, we do not take any 
extremist or fundamental approaches to the delivery of technical solutions for 
this project. We recognise there are Internet Cultures (in a wide variety of 
flavours) and that to adopt any one culture would be a folly. The UNINEW 
approach can best be exemplified by our attitude to one extremist group in the 
Internet culture, this group believes that all browsers should be text only and 
non-graphical. If UNINEW were asked to provide a technical solution for a 
group of partially sighted people then this would be a sensible route forward and 
we would adopt it, but for a visual oriented designer it would be nonsense. In 
addition UNINEW believe that the Internet Culture is evolving as fast as the 
software tools and there is an equally great danger of becoming locked into an 
obsolete culture as there is of becoming constrained by a specific software tool. 
Fourthly and finally, to address the technical specifics of FUNREDES's 
comments. 

4. Composing mail on-line Vs off-line. Within the scope of the Pilots we 
do not see this as an issue. We propose that all communication of a 
voluminous nature will be sent as document attachments, composed off-
line and dispatched with immediate confirmation of receipt on-line.  

5. Outlook on the PC. This is an alternative for users instead of the WEB 
browser Outlook, the basic Microsoft Exchange mailer, indeed any 
POP3/SMTP compliant mailer (Netscape, Eudora) can be used in 
parallel with WEB Browser interface, on or off-line. If the Pilots need 
such a software interface it can easily and cheaply be exploited if 
necessary. The advantage of the browser approach stated is that 
sophisticated interfaces and functionality can be developed within WP2 
without having to distribute additional software to the CAD bureaux.  

6. The comment about WEB based off-line writing of emails could take 
five times longer, UNINEW do not propose that this should happen 
and are unsure what is meant.  

7. The example of the "business as usual failure" and the associated 
reference 4 in the "remaining issues" section needs to be discussed. We 
did indeed send an RTF file that was large (740 KB) to the CaribCAD 
listserv. It was rejected because the listserv has been configured to reject 
mail over 100KB. FUNREDES explain this by stating it has built in 
accordance with the rules of the Internet community. Then I must raise 
the questions, "Is the listserv configured thus the correct technical 
solution for small research projects with a known and finite number of 
members that want to exchange large documents and files"? Other 
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listserv communities adopt different rules, such as warning all members 
that they are about to send a large mail. It would be useful to have the 
rules of the Internet Community transparent in order that WP2 does not 
propose solutions that contravene them.  

In conclusion, UNINEW do not agree nor advocate that two approaches are 
necessary or even a reality. We look forward to Funredes providing training on 
methodology and Internet culture to the CaribCAD members but do not see 
that the technical solution proposed to WP precludes this in anyway. 
 


